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Before You Read This Guide
Thank you for choosing CLIP STUDIO PAINT. The following describes points to keep in mind when 
reading this guide.

Regarding The Content of This Guide
This guide (including data) has been prepared and edited based on the product program available as of February 2014 
and may differ from the actual product program specifications.

Symbols Used in This Guide
In this guide, symbols are used for operation-related comments. The symbols used have the following meaning:

I nd ica t e s i t ems t ha t may be ea si ly m is t a ken or mat t e r s to be awa re of when usi ng 
CLIP STUDIO PAINT.

Indicates tips and supplementary information useful when using CLIP STUDIO PAINT.

Regarding the Product Line-up
CLIP STUDIO PAINT includes two product lines. This guide describes the operating procedure of both product lines. 
Functions restricted to a product line are marked with a symbol indicating the product line.

Unmarked Indicates a function common to both product lines.

[PRO/EX] Indicates functions that are supported for CLIP STUDIO PAINT PRO and EX only.

[EX] Indicates a function available only in CLIP STUDIO PAINT EX.

Trademarks and Copyrights
●  CELSYS, CLIP STUDIO, CLIP, QUMARION, IllustStudio and ComicStudio are trademarks or registered trademarks 

of CELSYS, Inc.

●  Windows is a registered trademark of Microsoft Corporation in the United States and other countries.

●  Macintosh and Mac OS are registered trademarks of Apple Inc. in the United States and other countries.

●  Adobe, the Adobe logo and Adobe Reader are trademarks of Adobe Systems Incorporated in the United States and 
other countries.

●  All other company names and product names described herein are trademarks or registered trademarks of their 
respective holders.

●  No part of this guide (including data) may be reproduced or copied in any form or by any means without permission 
from the copyright holder, except when so required by law.

Supported Operating Systems
CLIP STUDIO PAINT is available in two versions: Windows and Macintosh. This guide covers both unless otherwise 
noted.
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Regarding Operations Described in This Guide
Operations in this guide are described based the Windows version unless otherwise noted. If you are a Mac OS X user, 
replace and read as follows:

Windows Mac OS X
[Alt] key [Option] key
[Ctrl] key [Command] key
[Enter] key [Return] key
[Backspace] key [Delete] key
Right click Mouse click with the [Control] key down
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Before Drawing Manga or Comic Illustrations with CLIP STUDIO PAINT

What You Can Do with CLIP STUDIO PAINT
CLIP STUDIO PAINT is a software application with everything you need to draw manga or comic 
illustrations, such as a pen tool to draw naturally and with real-touch, a brush tool that allows a wide 
range of color expressions, and an easy-to-use painting tool to paint efficiently and beautifully.

This chapter introduces what you can do with CLIP STUDIO PAINT using illustrations drawn with 
CLIP STUDIO PAINT

Natural and Real-touch to Support a Wide Range of Expressions
Advanced pen pressure detection function to allow for a natural, real-touch pen experience.

The pen tool comes with a "compensation function" to smooth hand-drawn lines, as well as a variety of settings for 
customizing lines, such as "stroke-in" and "stroke-out" to start and end lines, "brush stroke" to add a fading-out effect at 
the end of lines, and brush shapes selectable based on the type and conditions of the lines to draw.

  
[Tool property] palette and

[Sub Tool Detail] palette for making detailed settings[PRO/EX]
Natural and smooth pen tool

Wide Range of Color Expressions
From delicate watercolor to massive oil painting and to anime painting a cell animation, the paint tool allows for a 
variety of painting modes to suit any creator's style.

The brush tool can be customized by changing the brush shape, adding texture, reproducing the watercolor border, and 
so on. The customized tool can then be saved as your original brush.

The [Decoration] tool allows you to draw complicated patterns with lace, chain, vegetation and so on. There are also 
patterns that can be used to show feelings or backgrounds. 

Expression in watercolor-touch Diverse decoration tools
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Free Resolution for Beautiful Lines and High Editability [PRO/EX]
The extended vector format now supports pencil and brush in addition to pen. With vector format, you can change the 
shape and/or thickness of lines even after they are drawn as the beautifulness of the lines does not change with scale. The 
vector format also allows you to erase a line up to the intersection of two given lines, or erase one of two overlapping 
lines.

   
Shapes drawn with different brush shapes of the pen tool

　
Applying "Erase until intersection" on the gray line in vector 
format

Shape of lines can be changed freely afterwards

Also Useful for Manga Authoring: Infinite Tones and Other Features [PRO/EX]
CLIP STUDIO PAINT has all the necessary functions to draw manga such as create border and frame border, draw 
effect lines, specify tone and create balloons.

Especially for tone functions, essential to manga. Just by enabling effect [Tone] on [Layer property], you can convert 
the content of a drawing into a black-and-white halftone dot tone, which you can freely change at any time by adding or 
deleting relevant areas, changing the number of lines and density, or changing the shape of the halftone dot.

CLIP STUDIO PAINT has [Frame border folder] which will allow you to draw frame borders just by dragging on the 
canvas.

Representat ion in black-and-white half tone dots by 
tonization

 
Directly converting a drawn content into a halftone dot tone
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Before Drawing Manga or Comic Illustrations with CLIP STUDIO PAINT

Startup
How to start CLIP STUDIO PAINT.

1. A CLIP STUDIO PAINT shortcut will be automatically created on the desktop when the installation of 
CLIP STUDIO PAINT has completed. Click the icon on your desktop.

2. CLIP STUDIO PAINT starts.

A white vertical canvas will automatically be created immediately after startup. A canvas (the white area displayed 
in the center) is similar to the paper you use to draw illustrations in the real world. With CLIP STUDIO PAINT, 
you will draw on this canvas.

Screen parts
The following palettes and the like are displayed by default.

(1) [Tool] palette To choose tools to draw illustrations and manga.
(2) [Sub tool] palette To change the settings of each tool.
(3) [Tool property] palette To adjust the selected sub tool settings.
(4) [Brush size] palette To adjust the size of the brush you are currently using.
(5) [Color] palette To choose the color in which to draw.
(6) [Command] bar To speed up operations to create new or save canvases, among others.
(7) [Material] palette To manage a variety of materials to use when drawing illustrations and manga. 

Materials can be dragged and dropped onto the canvas for use.
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(8) [Navigator] palette To manage how to display images displayed on the canvas window. You can adjust 
the display position, scale, angle, etc.

(9) [Sub view] palette [PRO/EX] To display a painting reference image. You can acquire the color to use from that 
image.

(10) [Layer proper ty] palet te 
[PRO/EX]

To make a variety of layer settings. It can also be used to display and switch tools 
and sub tools available for use in the selected layer.

(11) [Layer] palette [PRO/EX] To operate the "Layer" functions necessary for drawing CG illustrations and 
manga.

Preparations
Basic preparations necessary for drawing an illustration are as follows.

Changing the Size and Resolution of the Canvas
Starting CLIP STUDIO PAINT automatically creates a canvas.

To create a canvas that fits your specification, you must change the settings or create a new canvas.

Changing the settings
From the [Edit] menu, select [Change Image Resolution] or [Change Canvas Size].

With [Change Image Resolution], you can change the "width" and "height" proportionally.

With [Change Canvas Size], you can change the "width" and "height" freely.
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Before Drawing Manga or Comic Illustrations with CLIP STUDIO PAINT

Creating a new canvas
From the [File] menu, select [New]. Specify "Width", "Height", "Resolution", "Basic expression color" and so on and click 
[OK].

●  Setting a name in the [Register to preset] dialog box displayed when you click [Register to preset] adds the 
settings defined here to [Preset].

●  Some settings are pre-installed as [Default size]. Clicking the portion labeled "Custom" displays a list of pre-
installed settings from where you can choose one.

Trying the Drawing Tool
First, try drawing lines on the canvas.

With pen tablets, line thickness changes in accordance with the pressure applied to draw the lines: thick if the tablet 
is pressed hard or thin if pressed lightly. There are a variety of drawing tools, such as [Pen], [Pencil] and [Decoration] 
among others.

To delete all of what you drew on the tablet, click the [Delete] button.

Tips: If you made a mistake while operating
If you made a mistake while operating, you can revert to the state before the operation. Clicking the [Undo] button on the 
[Command] bar reverts the computer state by one operation.

[Undo]  
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Adjusting the Pen Pressure
CLIP STUDIO PAINT allows you to set pen pressure for each brush, but the following describes the function to adjust 
the pen pressure for all tools that make use of the pen pressure.

Select [File] menu ([CLIP STUDIO PAINT] menu in Mac OS X)  → [Pen Pressure Settings] to display the [Auto adjust 
pen pressure] dialog box.

Check that [Adjust] is turned on and select [Adjust by single stroke] or [Adjust by multiple strokes]. Draw a stroke on the 
screen by alternatively pressing hard and soft on purpose.

Stroke drawn by alternatively

pressing hard and soft on purpose

The graph changes in accordance with the detected pen pressure. Clicking [OK] applies the strength-matching pen 
pressure settings to all tools.
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Before Drawing Manga or Comic Illustrations with CLIP STUDIO PAINT

Page Management [EX]
CLIP STUDIO PAINT EX allows you to create a "management file" to manage multi-page manga or 
comic. The following describes how to operate the management file.

Creating a Management File
From the [File] menu, select [New]. On the [New] dialog box, turn on [Multiple pages] and specify the number of pages. 
Click [OK] to create the management file.

Configuring the binding point and start page
To configure the binding point and start page for a manga or comic book, click the [Binding Point/Start Page] button on 
the [New] dialog box.

Managing Multiple Pages
The following describes how to manage multiple pages using the management file.

Page manager window
This is the window for managing management files. To display the window, select [Story] menu → [Page Manager]. To 
open a page file, double click the page thumbnail.
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Adding and deleting pages
On the [Page manager] window, click the page thumbnail to select.

To add a new page at the end of the selected page, select [Story] menu → [Add Page].

To delete the selected page, select [Story] menu → [Delete Page].

Changing the order of pages
On the [Page manager] window, select the page whose order you want to change and drag to the new position.

Drag to the new

position

Creating a 2-page spread from a single page or vice versa
To create a 2-page spread, select the pages you want to change into a 2-page spread on the [Page manager] window. 
Then, select [Story] menu → [Combine Pages]. Furthermore, to create single pages from a 2-page spread, select [Story] 
menu → [Split Pages]. Note that neither operation can be undone with [Undo].

Originals for two pages Integration to create a 2-page spread

Changing the displayed page
To change the displayed page, click the [Switch canvas] tab.

Saving the Management File
The first time you save a management file, a management folder is created to store the management file. The folder will 
store the page files (extension: lip) along with the management file (extension: cmc).

Management folder

Content of the management folder

Management file Page files
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Before Drawing Manga or Comic Illustrations with CLIP STUDIO PAINT

Basic Operations of the Canvas and Shortcuts
When drawing an illustration or manga, you can zoom in the view to draw details or zoom out the view 
to check the total balance. The following describes basic operations you need to know for drawing on 
the canvas.

Basic Operations of the Canvas

Zooming in and out the canvas
A slider and buttons for scale adjustment are available at the lower left of the canvas and on the [Navigator] palette.

(1) Slider: Moving it to the left zooms out the canvas view while moving to the right zooms in the canvas view.

(2) [-]:  Zooms out the canvas view.

(3) [+]:  Zooms in the canvas view.

Displaying the entire canvas
Simultaneously pressing the [Ctrl] and [0 (zero)] keys on the keyboard displays the canvas entirely.

With Mac OS X, simultaneously press the [Command] and [0 (zero)] keys.

Scrolling the canvas
Scroll bars are available at the bottom and on the right of the canvas. By moving the scroll bar, you can move the display 
position of the canvas in the vertical or horizontal direction.

You can also move the display position using the [Move] tool on the [Tool] palette. On the [Tool] palette, select the 
[Move] tool and then, the [Hand] tool from the [Sub tool] palette.
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You can freely move the canvas by clicking on it and dragging.

Horizontally reversing the canvas
When the current orientation is difficult for drawing, or you want to check the balance while drawing, you can reverse 
the canvas view.

Click [Flip Horizontal] on the [Navigator] palette.
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Before Drawing Manga or Comic Illustrations with CLIP STUDIO PAINT

From the [View] menu, select [Rotate/Invert] and then, [Flip Horizontal].

Rotating the canvas
When the current orientation is difficult for drawing, you can rotate the canvas view to a convenient angle.

Move the slider or click the buttons at the lower left of the canvas window or on the [Navigator] palette.
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From the [View] menu, select the desired rotation from [Rotate/Invert].

On the [Tool] palette, select the [Move] tool and then, [Rotate] from the [Sub tool] palette. You can rotate by dragging on 
the canvas.

Frequently Used Shortcuts
You can greatly improve your work efficiency if you perform the above described operations using shortcuts. Here is a 
list of useful shortcuts.

Windows Macintosh

Undo last operation [Ctrl] + [Z] [Command]+[Z]

Fit to screen [Ctrl] + [0 (zero)] [Command] + [0 (zero)]

Zoom in (Switch to [Zoom]) [Ctrl] + [Space]
[Space] + [Command]

* Press [Space] first.

Zoom out (Switch to [Zoom]) [Alt] + [Space] [Option] + [Space]

Move screen (Switch to [Hand]) [Space] [Space]

Rotate canvas [Shift] + [Space] [Shift] + [Space]

Clear [Delete] [Delete]

Switched to [Magnifier] tool, the mouse zooms in and out the view as follows when dragged on the canvas.
Zoom in: Drag to the right
Zoom out: Drag to the left
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Before Drawing Manga or Comic Illustrations with CLIP STUDIO PAINT

Color Settings
How to choose colors when painting and drawing

The [Color Wheel] palette is selected by default. However, you can select the [Color set] palette by switching the tab.

Choosing a color with the [Color Wheel] palette
With the [Color Wheel] palette, you can choose hue from the peripheral circle, and brightness and saturation from the 
square in the center.

Choosing a color with the [Color Set] palette
With the [Color Set] palette, in addition to choosing your color from a list of typical colors, you can register frequently 
used colors as a [Color Set].

Saving
Save the completed illustration as a file to your computer. Saving frequently while still working on the 
illustration is recommended.

Saving with the Tool Bar

1. Click [Save] on the tool bar.

[Save]

2. The [Save] dialog box is displayed.

Specify the location, file name and file type, and click [Save].
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Saving with the [File] Menu

1. From the [File] menu, select [Save].

2. The [Save] dialog box is displayed.

Specify the location, file name and file type, and click [Save].

Your files can be saved in CLIP STUDIO PAINT format (extension: lip), BMP, JPEG, PNG, TIFF, Targa, Adobe 
Photoshop document (extension: psd) and Adobe Photoshop large document (extension: psb).

When a file is saved using [File] menu → [Export (Layerd)] → [.lip (Optimization)], its size may become 
smaller if layers are removed when it is worked on. However, this optimization does not affect the image quality.
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Before Drawing Manga or Comic Illustrations with CLIP STUDIO PAINT



Drawing Illustrations 
with CLIP STUDIO PAINT

Basic Part
This part describes the basic methods for

drawing illustrations with CLIP STUDIO PAINT.
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Drawing Illustrations with CLIP STUDIO PAINT

Illustration Drawing Sequence - Basic Part
This part describes how to draw illustrations based on the sequence below.

Coloring
Create a layer for coloring and apply color by using the 
[Pen] tool and [Fill] tool.

Inking
Ink over with the [Pen] tool based on the “Draft”.

Pencilling
Roughly draw the shape of the intended illustration 
to check layout and pose. Draw the “Draft” based on 
the rough shape.

Pencilling
First, create a new canvas and draw the draft of the intended illustration.

Drawing Lines
Use the [Pencil] tool to draw the draft.  Have the [Pencil] tool size adjusted in advance for easy use.

1. Select [File] menu → [New] to create a new canvas.

For details on how to create and configure a canvas, see "Before Drawing Manga or Comic Illustrations with 
CLIP STUDIO PAINT" → "Preparations" on Page 11.

2. On the [Tool] palette, select the [Pencil] tool.
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Basic Part

3. Adjust the size of the [Pencil] tool.

Adjust by specifying the [Tool] properties, or choose a size from [Brush Size].

4. Specify the line color. Choose any color other than black so that you can easily recognize the draft lines 
afterwards, when you ink over with the [Pen] tool.

On the [Color Set] palette, click light blue to select. To display the [Color Set] palette, select [Window] menu → 
[Color Set].

5. Draw on the canvas.
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Drawing Illustrations with CLIP STUDIO PAINT

Correcting Lines
To erase a drawn line, use the [Eraser] tool.

1. On the [Tool] palette, select the [Eraser] tool.

2. Adjust the size of the [Eraser] tool.

Adjust by specifying the [Tool] properties, or choose a size from [Brush Size].

Completing the Draft
Roughly draw the shape and add details thereafter. Gradually complete the draft by drawing and correcting until the 
draft is complete.
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Basic Part

Inking
The following describes how to perform inking along with "layer", which you will use in all 
subsequent tasks.

What is a Layer?
When drawing illustrations and manga with digital paint tools such as CLIP STUDIO PAINT, you use what is called a 
"layer". A layer is something similar to a transparent film.

You draw everything, including lines and colors, on this transparent layer. On the canvas, all layers are displayed 
overlapped.

If lines and color, characters and background are drawn in separate layers, you can make corrections easily, or erase 
what is drawn just by hiding the layer.

Layers are overlapped in the order they are displayed on the [Layer] palette. When combine mode is normal, drawings in 
lower layers are hidden by the upper layers.
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Drawing Illustrations with CLIP STUDIO PAINT

Creating a Layer
Create a layer for drawing lines. By separating the layer from that of the draft, you can have only the line drawing data 
just by hiding the draft layer.

1. On the [Layer] palette, click the [New Raster Layer] button to create a new layer. The layer whose name field 
part is displayed in blue is the currently selected layer.

Click [New Raster Layer].

2. Double click the layer name field and input "Line drawing".

Double click.

Inking
Draw the lines by referring to the draft. If you make a mistake, erase with the [Eraser] tool, or [Undo] and complete your 
line drawing.

Since you created the "Line drawing" layer above the "Draft" layer, you will notice the light blue pen lines of the draft 
disappear behind black lines as you ink over.
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Basic Part

Completing Ink Over
When you have finished inking, leave only the line drawing by hiding the "Draft" layer.

1. On the [Layer] palette, click the [Show/Hide Layer] icon on the left side of "Draft" to hide.

2. The draft layer is hidden and only the main lines are displayed. This is the end of inking. By separating 
layers, you do not need to erase as when you work in the analog world.

Coloring
The following steps describe how to color the illustration.

Coloring the Body

Preparing a layer for coloring the body
Create a layer for coloring the body.

1. On the [Layer] palette, click the [New Raster Layer] button  to create a new layer.

Click [New Raster Layer].
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Drawing Illustrations with CLIP STUDIO PAINT

2. Double click the layer name field and input "Body".

Double click.

3. Move the "Body" layer below the "Line drawing" layer to avoid the lines from being hidden.

Click the name field of the "Body" layer and directly drag down to below the "Line drawing" layer.

Preparing the tool
Prepare the tool to color the body.

1. On the [Tool] palette, select the [Pen] tool.

2. Adjust the size of the [Pen] tool.

Adjust by specifying the [Tool] properties, or choose a size from [Brush Size].
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Basic Part

3. On the [Color Set] palette, choose a color for the body.

Coloring
Paint the body.

Use the [Eraser] tool to erase running over parts. On the [Tool] palette, select the [Eraser] tool to tidy up.
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Drawing Illustrations with CLIP STUDIO PAINT

Coloring Spots

Preparing a layer for coloring spots
Create a layer for coloring spots.

1. On the [Layer] palette, click the [New Raster Layer] button to create a new layer.

Click [New Raster Layer].

2. Double click the layer name field and input "Edge".

Double click.

Creating a layer adds the layer above the one selected originally.

If the "Spot" layer is above the "Line drawing" layer, move it down to below the "Line drawing" layer as in the case 
above.
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Basic Part

Preparing the tool
Prepare the tool to color the spots.

1. On the [Tool] palette, select the [Pen] tool.

2. On the [Color Set] palette, choose a color for the spots.

Coloring
Paint the spots.

1. Paint the spots.

2. Use the [Fill] tool to paint the enclosed areas. On the [Tool] palette, select [Fill] tool and then, [Refer other 
layers] from the [Sub Tool] palette.
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Drawing Illustrations with CLIP STUDIO PAINT

3. Check that [Multiple referring] on the [Tool property] palette is selected.

4. Click inside the spots.

Click.

For details on "Multiple referring", see "Drawing illustrations with CLIP STUDIO PAINT - Advanced Part" → 
"Basic Coloring" → "Tips: Layer reference" on Page 49.

Coloring the Ears

Preparing a layer for coloring the ears
Create a layer for coloring the ears.

1. On the [Layer] palette, click the [New Raster Layer] button to create a new layer.

Click [New Raster Layer].
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Basic Part

2. Double click the layer name field and input "Ear".

Double click.

Preparing the tool
Prepare the tool to apply color to the ears.

1. On the [Tool] palette, select the [Fill] tool and then, [Refer other layers] from the [Sub Tool] palette.

2. Check that [Multiple referring] on the [Tool Property] palette is selected.
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3. On the [Color Set] palette, choose a color for the ears.

Coloring
Paint the ears. Click inside the ears as you did when coloring spots.

Click.

Completing
The giraffe illustration is now complete.



Drawing 
Illustrations with 

CLIP STUDIO PAINT

Advanced Part
This part describes how to use more advanced functions to

draw illustrations with shadow, and using background materials.
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Illustration Drawing Sequence - Advanced Part
This part describes how to draw illustrations based on the sequence below.

Draw the “Draft” of the intended illustration to check 
layout and pose.

Pencilling

Inking
Ink over with the [Pen] tool based on the “Draft”.

Coloring
Create a layer for coloring and apply basic color and 
shadow by using the [Fill] tool.

Finishing
Finish the illustration by adding highlights and stacking 
a background material.

Pencilling

Creating a New File
First, create a new canvas.

1. Select [File] menu →[New] to open the [New] dialog.

Click [Preset] and select [B5(350dpi)]. Click [Switch width/height] under [Canvas size] to change the canvas 
orientation. If [Manga draft settings] is turned on, turn it off and click [OK].
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●  For details on how to create and configure a canvas, see "Before Drawing Manga or Comic Illustrations with 
CLIP STUDIO PAINT" → "Preparations"on Page 11.

●  Configuring items under [Canvas size] after selecting a [Preset] changes [Preset] to [Custom].

Once you have created a new canvas, draw the draft of the intended illustration. Use the [Pencil] tool to draw the draft. 
Have the [Pencil] tool size adjusted in advance for easy use.

Preparing the Pencil Tool
Prepare the tool to draw the draft.

1. On the [Tool] palette, select the [Pencil] tool.

2. Adjust the size of the [Pencil] tool.

Adjust the brush size of the [Pencil] tool with the [Brush Size] slider on the [Tool Property] palette, or by selecting a 
size from the [Brush Size] palette.
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Drawing the Draft
Work on the draft.

1. Specify the color for drawing the draft.

Specify the color to use for drawing the draft lines. Choose any color other than black so that you can easily 
recognize the draft lines afterwards, when you ink over in black.

On the [Color Set] palette, click light blue to select.

2. Draw the shape roughly.

Draw roughly by displaying the whole canvas.

3. Once you have the rough shape drawn, add the details.

You can zoom in the area you want to draw, or rotate the view to a convenient angle. Furthermore, occasionally 
horizontally reverse the draft to check the total balance.

For details on how to zoom in, rotate or horizontally reverse the canvas, see "Before Drawing Manga or Comic 
Illustrations with CLIP STUDIO PAINT" → "Basic Operations of the Canvas and Shortcuts" on Page 16.
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Zooming in the canvas

Roughly draw the shape 
by displaying entirely. Zoom in to draw details.

Rotating the canvas

Rotate to a convenient 
angle for drawing.

Horizontally reversing the canvas

Horizontally reverse to 
check balance.

Correcting Lines
To erase a drawn line, use the [Eraser] tool.

1. On the [Tool] palette, select the [Eraser] tool and then, [Hard eraser] from the [Sub Tool] palette.
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2. Adjust the size of the [Eraser] tool.

Adjust the brush size of the [Eraser] tool with the [Brush Size] slider on the [Tool Property] palette, or by selecting 
a size from the [Brush Size] palette. A large size is useful for erasing large areas while a small size is useful for 
making detailed corrections.

3. Trace the line you want to erase.

Drag to erase.

Completing the Draft
Gradually complete the draft by drawing and correcting.

The draft is complete.
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Inking
When you are finished with the draft, the next step is to draw the main lines using the [Pen] tool. This 
task is called "inking". Prepare a layer for inking.

What is a Layer?
A layer is something similar to a transparent film. You draw everything, including lines and color, on this transparent 
layer.

If lines, color, and background are drawn in separate layers, you can make corrections easily, or erase what is drawn just 
by hiding the layer.

Layers are overlapped in the order they are displayed on the [Layer] palette. Drawings in lower layers are hidden by the 
upper layers.

Preparing the Layer
Layer operations are performed on the [Layer] palette located at the bottom right of the canvas window.

Name the layer for easy identification as the layer for inking will be placed above the layer with the draft. On the [Layer] 
palette, double click the name field and input "Draft".
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Preparing a Layer for the Main Lines
Next, create a layer for drawing the main lines. By separating the layer from that of the draft, you can have only the main 
line data just by hiding the draft layer.

1. On the [Layer] palette, click the [New Raster Layer] button to create a new layer.

2. Double click the layer name field and input "Main line".

With the [Pen] tool, draw the main lines based on the draft.

Selecting the Layer
On the [Layer] palette, check whether the "Main line" layer is selected. The layer whose name field is displayed in blue is 
the selected layer.

If the "Draft" layer is selected and you draw the main lines directly on the draft, not only is your effort to separate layers 
wasted but correcting main lines and erasing draft lines becomes more difficult.

Preparing the Pen Tool
Adjust the [Pen] tool for inking.
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1. On the [Tool] palette, select the [Pen] tool and then, [G-pen] from the [Sub Tool] palette.

2. Adjust the size of the [Pen] tool.

Adjust the brush size of the [Pen] tool with the [Brush Size] slider on the [Tool Property] palette, or by selecting a 
size from the [Brush Size] palette.

3. On the [Color Set] palette, click [Black] to select.

Inking
Draw the lines by referring to the draft.

  

Since you created the "Main line" layer above the "Draft" layer, you will notice the light blue pen lines of the draft 
disappear behind black lines as you ink over.
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Making Corrections to Lines
To correct a drawn line, use the [Eraser] tool.

1. On the [Tool] palette, select the [Eraser] tool.

2. On the [Tool Property] palette, drag the [Brush Size] slider to adjust the [Eracer] tool size.

3. Trace the line you want to erase.

Drag to erase.

Since the draft is on a separate layer, erasing a main line does not erase the light blue line of the draft.

Continue inking using the [Pen] tool and the [Eraser] tool.
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Completing Inking
When you are finished with inking, leave only the main lines by hiding the "Draft" layer.

1. On the [Layer] palette, click the [Show/Hide Layer] icon on the left side of "Draft" to hide the layer.

2. The draft layer is hidden and only the main lines are displayed.

This is the end of inking.

With separate layers, you do not need to erase the draft.



48

Drawing Illustrations with CLIP STUDIO PAINT

Basic Coloring
Paint the illustration. Paint the colors that will be the base of color separation first.

Prepare separate layers for each color type and area so that only one color is used in one layer.

Coloring with Solid Black
First color the (solid) black areas of the line drawing.

1. Prepare the Layer
Create a layer for coloring.

1. On the [Layer] palette, click the [New Raster Layer] button to create a new layer.

Double click the layer name field of the created layer and input "Fill in black".

2. Move the "Solid black" layer below the "Main line" layer to avoid lines from being hidden.

Click the name field of the "Solid black" layer and directly drag down to below the "Main line" layer.

2. Prepare the Tool
Use the [Fill] tool to paint.

1. On the [Tool] palette, select the [Fill] tool and then, [Refer other layers] from the [Sub Tool] palette.
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2. On the [Tool Property] palette, check that [Multiple referring] is selected.

3. On the [Color Set] palette, choose black.

Tips: Layer reference
When drawing an illustration with CLIP STUDIO PAINT, having separate layers for each process step such as 
pencilling, inking, and coloring is convenient because corrections can be made easily. Once you become familiar with 
this feature, you may separate layers based on location and the like even for inking to further increase convenience.

Separating layers means coloring layers without any line. The areas to fill are drawn on the "Main line" layer, therefore, 
simply using Fill in a layer without any line applies color to the whole layer. Then, how do you paint only the relevant 
areas? 

Here comes in "Multiple referring".

By selecting "Multiple referring", you can refer to other layers for areas to fill.
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Multiple Referring

When [Refer other layers] is selected for the [Fill] tool, it fills by referring to all displayed layers. If the draft is visible, 
the draft lines will also be referred. To avoid surprises, hide all layers that are not used because the tasks on there are 
finished.

 Hide “Draft”.

3. Color
Fill in solid black. Click the areas you want to fill. Only those areas will be filled.

Tips: When Fill does not work as you want
If unintended areas are filled with Fill, the line is broken somewhere.

Broken line

Select [Edit] menu → [Undo] to restore the state before Fill and try again after connecting the broken portion(s) with the 
[Pen] tool and the like.

Correct with the Pen 

tool and the like.
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4. Paint Unfilled Areas
With the [Pen] tool, paint those areas the [Fill] tool failed to fill.

1. On the [Tool] palette, select the [Pen] tool and then, [G-pen] from the [Sub Tool] palette.

2. Adjust the size of the [Pen] tool.

3. With the [Pen] tool, neatly paint all unfilled areas.

4. Similarly fill eyelashes and other areas in solid black.

Solid black coloring is now complete. With the [Fill] tool, color each of the other areas in the same way.
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Coloring the Pupil

1. Prepare the Layer for Coloring the Pupil
Create a layer for coloring the pupil.

On the [Layer] palette, check that the "Draft" layer is selected. Then, click the [New Raster Layer] button.

Double click the layer name field of the created layer and input "Eye".

Creating a layer adds the layer above the one selected originally.

To avoid parts drawn on the "Eye" layer from running over the main lines, the "Eye" layer must be moved below the 
"Main line" layer and "Fill in black" layer if it is above them.

2. Prepare the Tool for Coloring the Pupil
Use the [Fill] tool to paint.

1. On the [Tool] palette, select the [Fill] tool and then, [Refer other layers] from the [Sub Tool] palette. On the [Tool 
Property] palette, check that [Multiple referring] is selected.

Here, the same settings as for painting solid black are used. For details, see "Basic Coloring" → "Coloring with 
Solid Black" → "2. Prepare the Tool" on Page 48.

2. On the [Color Set] palette, choose light brown.
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3. Color the Pupil
Click inside the pupil with the [Fill] tool.

After the pupil comes hair as it uses the same color.

Coloring the Hair

1. Prepare the Layer for Coloring the Hair
On the [Layer] palette, create a new layer for coloring the hair.

On the [Layer] palette, check that the "Draft" layer is selected. Then, click the [New Raster Layer] button.

Double click the layer name field of the created layer and input "Hair".

If the "Hair" layer is above the "Main line", "Solid black" and "Pupil" layers, move it down.

2. Prepare the Tool for Coloring the Hair
Use the [Fill] tool to paint.

1. On the [Tool] palette, select the [Fill] tool and then, [Refer other layers] from the [Sub Tool] palette. On the [Tool 
Property] palette, check that [Multiple referring] is selected.

Here, the same settings as for painting solid black are used. For details, see "Basic Coloring" → "Coloring with 
Solid Black" → "2. Prepare the Tool" on Page 48.
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2. On the [Color Set] palette, choose light brown.

3. Color the Hair
Click the hair area.

Click all hair areas to fill.

4. Paint Unfilled Areas
The [Fill] tool sometimes fails to fill small areas such as the thin tip of hair.

Since colors in lower layers become visible if unfilled areas are left as they are, paint them with the [Pen] tool.

Unfilled area
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1. On the [Tool] palette, select the [Pen] tool and adjust the tool size.

Here, the same settings as for painting unfilled areas in solid black are used. For details, see "Basic Coloring" → 
"Coloring with Solid Black" → "4. Paint Unfilled Areas" on Page 51.

2. With the [Pen] tool, neatly paint all unfilled areas.

When you are finished with the unfilled areas, coloring of the hair is complete.

The sun visor and T-shirt the character is wearing will be the next.

Create a new layer for each part to color as with the pupil and hair, and paint with the [Fill] tool. As for areas left 
unfilled, fill with the [Pen] tool.

When you have finished the above, then proceed to color the character's skin and mouth, and shadow.
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Coloring the Skin
Color the character's skin.

1. Prepare the Layer for Coloring the Skin
As in previous steps, add a new layer and name it "Skin".

Since skin is below the eyes and hair, move the created [Skin] layer down if it is above "Fill in black", "Eye" and other 
layers.

2. Color the Skin
As in previous steps, paint large areas with the [Fill] tool and the small, unfilled areas, with the [Pen] tool. Choose a pale 
skin color.
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3. Paint Unfilled Areas
Next, correct areas the [Fill] tool failed to fill.

In this example, unfilled areas are found around the eyes and close to the roots of the hair. However, white, unpainted 
areas are difficult to distinguish from the pale skin color.

To better recognize the unfilled areas, prepare a layer additional to the "Skin" layer with such color that the skin color 
becomes easily distinguishable.

1. With the "Draft" layer selected on the [Layer] palette, add a layer with the [New Raster Layer] button and name it 
"Background".

If the "Background" layer is at the top, move it just above the "Draft" layer.

2. To easily distinguish the areas that are painted in skin color from those that are not, choose green on the [Color Set] 
palette.

3. On the [Command bar], click the [Fill] button.
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The background is filled in green, making recognition of unfilled areas easy.

4. On the [Layer] palette, select the "Skin" layer.

5. On the [Tool] palette, select the [Pen] tool and then, [G-pen] from the [Sub Tool] palette.

Here, the same settings as for painting unfilled areas in solid black are used. For details, see "Basic Coloring" → 
"Coloring with Solid Black" → "4. Paint Unfilled Areas" on Page 51.

6. On the [Color Set] palette, choose pale skin color.

7. With the [Pen] tool, neatly paint all unfilled areas (green areas between the skin and main line).
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Coloring is finished up to the skin.

Coloring the Mouth
Next, paint the mouth.

1. Prepare the Layer for Coloring the Mouth
With the "Skin" layer selected on the [Layer] palette, add a layer with the [New Raster Layer] button and name it 
"Mouth". If the "Mouth" layer is below the "Skin" layer, move it up to above the "Skin" layer.

2. Close the Line
In the mouth of this illustration, the line in the lower portion is not continuous.

Just filling with the [Fill] tool as up until now would paint the whole face in the color for the mouth. To avoid this, the 
line in the lower portion of the mouth must be closed before coloring the mouth with Fill.
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1. On the [Tool] palette, select the [Pen] tool.

Here, the same settings as for inking the main lines are used. For details, see "Inking" → "Preparing the Pen 
Tool" on Page 44.

2. On the [Color Set] palette, choose orange.

3. Enclose the area to paint by extending the line from one corner of the mouth to the other.

3. Color the Mouth
When the lower line of the mouth is closed, apply color.

1. On the [Tool] palette, select the [Fill] tool and then, [All layers] from the [Sub Tool] palette. On the [Tool Property] 
palette, check that [Multiple referring] is selected.

Here, the same settings as for painting solid black are used. For details, see "Basic Coloring" → "Coloring with 
Solid Black" → "2. Prepare the Tool" on Page 48.

2. On the [Color Set] palette, check that the selected color is orange.

3. Click inside the mouth.

The mouth could be colored without spilling the color for the mouth as the mouth line was closed.
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Coloring of parts in red such as the mouth is now complete.

As the number of layers has increased considerably, check their order on the [Layer] palette.
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Coloring White Areas
Here, the white areas such as the white of the eye, highlights in the pupil of the eye and the brim of the sun visor will be 
colored.

1. Prepare the Layer for Coloring White Areas
With the "Skin" layer selected on the [Layer] palette, add a layer with the [New Raster Layer] button and name it 
"White".

Place the layer between the "Skin" layer and "Mouth" layer.

In this example, all white areas will be colored in the same layer. However, there is no problem if separate layers are 
created for each area to paint. When separating into multiple layers, be careful to place all layers to paint in white 
between the "Sun visor" layer and "Skin" layer.

2. Close the Line of the White of the Eye
As with the mouth, there is no main line drawn in a portion of the white of the eye. The broken line must be connected in 
advance with the [Pen] tool to close the white of the eye.

1. On the [Tool] palette, select the [Pen] tool.

Here, the same settings as for inking the main lines are used. For details, see "Inking" → "Preparing the Pen 
Tool" on Page 44.

2. On the [Color Set] palette, choose white.

3. Enclose the white of the eye by extending the line from one corner to the other of the eye in such a way as to 
include the pupil.
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3. Color the white area
Fill the white of the eye.

1. On the [Tool] palette, select the [Fill] tool and then, [Refer other layers] from the [Sub Tool] palette. On the [Tool 
Property] palette, check that [Multiple referring] is selected.

Here, the same settings as for painting solid black are used. For details, see "Basic Coloring" → "Coloring with 
Solid Black" → "2. Prepare the Tool" on Page 48.

2. On the [Color Set] palette, check that the selected color is white.

3. Click inside the white of the eye to fill.

4. On the [Tool] palette, select the [Pen] tool and adjust the tool size.

Here, the same settings as for painting unfilled areas in solid black are used. For details, see "Basic Coloring" → 
"Coloring with Solid Black" → "4. Paint Unfilled Areas" on Page 51.

5. Correct the unfilled areas with the [Pen] tool.

Similarly, fill the highlights in the pupil, parka and brim of the sun visor with the [Fill] tool and correct with the [Pen] 
tool.
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All of the white areas are now completely filled.

Drawing the Cheek Line
Draw the red cheek line, which is an accent, with the [Pen] tool.

1. With the "Pupil" layer selected on the [Layer] palette, add a layer with the [New Raster Layer] button and name it 
"Cheek line".

If the "Cheek line" layer is below the "Eye" layer, move it up to above the "Eye" layer.

2. From the [Tool] palette, select the [Pen] tool.

Here, the same settings as for inking the main lines are used. For details, see "Inking" → "Preparing the Pen 
Tool" on Page 44.

3. On the [Color Set] palette, check that the selected color is magenta.
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4. Draw the cheek line.

With the cheek line drawn, the basic coloring of the character is complete.
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Adding Shadow
Paint the character's shadow.

Shadow is painted over the previously colored area. By specifying [Lock Transparent Pixel] in 
advance, you can add shadow efficiently as non-colored areas will be excluded.

Tips: What is [Lock Transparent Pixel] ?
This is a function that prevents transparent areas (transparent pixels) of the layers from being drawn.

Layers where [Lock Transparent Pixel] is specified are displayed with a gray lock and a checkered icon.

        is displayed when 
“Lock Transparent Pixel” 
is specified.

Using this function will enable you to add shadow without running over the area where hair, skin and so on are painted.

Specifying [Lock Transparent Pixel] for the Layer for Shadow Painting
Select all layers to which shadow will be applied and specify [Lock Transparent Pixel].

On the [Layer] palette, select the "Eye" layer.

Successively click the [Layer draw ON/OFF] button of each of the "Hair", "Sun visor", "Mouth", "White", "Skin" and "T 
shirt" layers to select multiple layers at once.

Click the [Lock Transparent Pixel] button.
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Click

Click each of the other 
layers with the “Eye” layer 
selected.

[Lock Transparent Pixel] is specified for all of the selected layers at once.

Transparent pixels are 
locked.

Painting the Hair Shadow
Color the shadow. First, color the hair shadow.

1. Draw the Outline of the Shadow
Paint the hair shadow. First draw the shape of the shadow with the [Pen] tool.

1. On the [Tool] palette, select the [Pen] tool.

Here, the same settings as for inking the main lines are used. For details, see "Inking" → "Preparing the Pen 
Tool" on Page 44.
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2. On the [Color Set] palette, choose dark brown.

3. On the [Layer] palette, select the "Hair" layer.

4. Draw lines as if drawing the outline of the shadow shape. Make sure lines are perfectly connected and without 
discontinuity as these lines will become the enclosure where shadow will be painted with the [Fill] tool.

2. Fill the Hair Shadow
When you have finished the shadow lines, fill the inside.

1. On the [Tool] palette, select the [Fill] tool and then, [Refer other layers] from the [Sub Tool] palette. On the [Tool 
Property] palette, check that [Multiple referring] is selected.

Here, the same settings as for painting solid black are used. For details, see "Basic Coloring" → "Coloring with 
Solid Black" → "2. Prepare the Tool" on Page 48.
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2. On the [Color Set] palette, check that the selected color is dark brown.

3. Click inside the hair shadow.

Click to fill.

The hair shadow is now filled.

As for small, unfilled areas, correct with the [Pen] tool.

Here, the same settings as for painting unfilled areas in solid black are used. For details, see "Basic Coloring" → 
"Coloring with Solid Black" → "4. Paint Unfilled Areas" on Page 51.

Color the shadow of other areas in the same way.
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Painting the Sun Visor Shadow
Color the sun visor shadow following the same procedure as that for the hair shadow. The used tools are also the same.

On the [Color Set] palette, choose dark red.

On the [Layer] palette, select the "Sun visor" layer and draw the outline of the shadow shape with the [Pen] tool.

Click with the [Fill] tool to fill.

Click to fill.

As for unfilled areas, correct with the [Pen] tool.

Painting the Mouth Shadow
Color the mouth shadow following the same procedure as that for the hair shadow. The tools to use are also the same.

On the [Color Set] palette, check that the selected color is dark red.

On the [Layer] palette, select the "Mouth" layer and draw the outline of the shadow shape with the [Pen] tool.
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Click with the [Fill] tool to fill.

Click to fill.

As for unfilled areas, correct with the [Pen] tool.

Drawing the Shadow of White Areas
Color the shadow of white areas following the same procedure as that for the hair shadow. The used tools are also the 
same.

On the [Color Set] palette, choose bluish gray.

On the [Layer] palette, select the "White" layer and draw the outline of the shadow shape with the [Pen] tool.

Click with the [Fill] tool to fill.

Click to fill.

As for unfilled areas, correct with the [Pen] tool.
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Painting the Skin Shadow
Color the skin shadow following the same procedure as that for the hair shadow. The used tools are also the same.

On the [Color Set] palette, choose dark red.

On the [Layer] palette, select the "Skin" layer and draw the outline of the shadow shape with the [Pen] tool.

Click with the [Fill] tool to fill.

Click to fill.

As for unfilled areas, correct with the [Pen] tool.
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Painting the T-shirt Shadow
Color the T-shirt shadow following the same procedure as that for the hair shadow. The used tools are also the same.

On the [Color Set] palette, choose blue.

On the [Layer] palette, select the "T-shirt" layer and draw the outline of the shadow shape with the [Pen] tool.

Click with the [Fill] tool to fill.

Click to fill.

The shadow areas of the T-shirt are now filled.

All of the shadows are now painted.
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Adding Highlight and Background for Finishing
Highlights such as the gloss of the hair and background will be added next.

Drawing the Highlight
Add gloss to the hair and shine (highlights) to the pupil.

1. Prepare the Layer for Highlights
On the [Layer] palette, create a new layer by clicking the [New Raster Layer] button and name it "Highlight".

Highlights are added on top of painted areas. However, they must not run over the main lines. For this reason, the layer 
for the highlights must be above the layers where other areas are colored but below the layer with the main lines.

If the created "Highlight" layer is above the "Solid black" layer, move it down.

2. Draw the Highlights
First draw the gloss of the hair with the [Pen] tool.

1. From the [Tool] palette, select the [Pen] tool.
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2. Adjust the size of the [Pen] tool.

Adjust the brush size of the [Pen] tool with the [Brush Size] slider on the [Tool Property] palette, or by selecting a 
size from the [Brush Size] palette.

3. On the [Color Set] palette, choose golden yellow.

4. Roughly draw the shape of the gloss.
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3. Adjust the Highlights
Adjust the shape of the highlights with the [Eraser] tool.

1. On the [Tool] palette, select the [Eraser] tool.

2. On the [Tool Property] palette, drag the [Brush Size] slider to adjust the tool size.

3. Erase unnecessary areas to adjust the shape.

Add gloss to the hair using the [Pen] tool and [Eraser] tool.
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4. Add Shine to the Eye
Add highlights to the pupil with the [Pen] tool.

1. From the [Tool] palette, select the [Pen] tool.

Here, the same settings as for inking the main lines are used. For details, see "Inking" → "Preparing the Pen 
Tool" on Page 44.

2. On the [Color Set] palette, check that the selected color is golden yellow.

This time, the same color is used for highlight as both hair and eye are of the same color.

3. Draw circles of shine on the pupil.

With the highlights added, coloring of the character is now complete.
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Creating the Background
CLIP STUDIO PAINT includes a variety of materials for illustrations and manga. This time, a background image will be 
used to complete the illustration.

1. Hide the "Background" layer filled in green since a background image will be added immediately above the "Paper" 
layer.

Click the [Show/Hide Layer] icon for the "Background" layer to hide.

2. On the [Material] palette, click the "Minimize palette dock" icon to display the list of materials.

Click.
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3. From the list of materials, choose the background image "Sea_04" and drag and drop it onto the canvas.

Drag and drop.

Dragging and dropping the background image onto the canvas adds the "Sea_04" layer immediately above the 
"Paper" layer.

Adding a background image automatically selects the [Object] corresponding to the [Operation] tool on the [Sub 
Tool] palette.

While the [Object] tool is selected, a guide line is displayed on the background image.
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4. Adjust the size and position of the background image by dragging a handle on the guide line or the guide line.

Drag the guide line to move.

Drag the handle to zoom 
in/out.

5. The illustration is complete! Select [File] menu → [Save] to save the completed illustration.

For de t a i l s on how to save a f i le , s ee "Before D r aw i ng Ma nga or Com ic I l lu s t r a t ion s w i t h 
CLIP STUDIO PAINT" → "Saving" on Page 21.



Drawing Manga with 
CLIP STUDIO PAINT

Monochrome Manga Part

[PRO/EX]
This part describes how to draw manga with printing in mind.
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Drawing Sequence of Manga for Print
This part describes how to draw manga for printing based on the sequence below.

Create the dialogue layer to express words. Create a 
[Frame border folder] for each frame to draw the border.

Draw drafts of sound effects, characters and effects 
separated into different layers. Ink over with the [Pen] 
tool based on the draft. Line drawing is produced as a 
result of this task.

Decide on the story and draw the storyboard. The 
storyboard is drawn to construct the story and 
structure of the content.

Creating the File and Storyboard

Creating the Balloons, Dialogue and 
Borders

Pencilling and Inking Characters

Create dedicated fill in monochrome, tone and 
gradient layers to express colors.

Adding Fill in monochrome, Tone and 
Gradient.

Finish the manga by adding effects, highlight and sound 
effects. When the manga is complete, save the file.

Adding Effects, Sound Effect and 
Highlight
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Creating the File and Storyboard
Before drawing the draft of the manga, its storyboard must be created. A storyboard is a roughly 
drawn basic plan of the story to work out the content.

Preparing and Creating a New File
First, create a new canvas with printing in mind.

First select [File] menu → [Preferences]. (In the Mac OS X version, [CLIP STUDIO PAINT] menu → [Preferences].)

On the [Preferences] dialog box, select [Ruler/Frame/Unit], then [mm] for [Unit] and click [OK].

From the [File] menu, select [New].

On the [New] dialog box, configure the size and other items as required, and click [OK]. The settings for this example 
are as follows:
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●  The "Width: 210mm x Height: 297mm" size configured in the [Canvas size] corresponds to A4 size. Digital 
originals are drawn in original size, but a canvas size of A4, which, in this case is the next size is automatically 
configured by default if B5 is configured for [Bound (final) size] to take bleed (margin) into account.

●  Turning on [Settings for original of manga] allows you to configure the size of the finalized bound book, bleed 
width and the like in detail.

Tips: What is expression color?
Expression color is a term that indicates the colors that can be used in a file or layer. CLIP STUDIO PAINT allows you to 
configure three types of expression color: Monochrome, Gray and Color for each layer, which you can configure on the 
[New Raster Layer] dialog box or the [Layer Property] palette.

   

In addition, if you have [Basic expression color] configured on the [New] dialog box, each new layer you will add to the 
canvas will be automatically configured with that expression color.

Monochrome

This expression color allows you to use one or two colors and transparent. It allows you to create a perfect duotone 
data (binary picture). By configuring, you can change the drawing color (the color to use in a layer) among black and 
transparent, white and transparent, and black and white and transparent.

Use this expression color in manga data for printing, line drawing layer and the like. "Monochrome" is ideal for creating 
originals of manga for printing in black and white.

Monoch rome ( bla ck , wh i t e a nd 
transparent)

Monochrome (black and transparent)

Monochrome (white and transparent)
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When a layer expression color is monochrome, anything drawn on that layer becomes binary data even if anti-aliasing 
or gradient is applied. Furthermore, anything drawn using any color other than black, white and transparent becomes 
[black] if the color is dark and [white] if the color is light.

The figures below show the same drawing made using [Decoration] tools configured with the same settings, one on a 
layer whose expression color is Color and the other on a layer whose expression color is Monochrome.

When drawn on a color layer When drawn on a monochrome layer

To express gradient when printing in black and white, enable [Tone] on the [Layer Property] palette after drawing on a 
Gray or Color layer. By converting to tone, you can express gradient artificially.

Gray

This expression color allows you to use 256 achromatic colors.

It allows you to configure a combination of black and transparent, white and transparent or black and white, each of 
which will be available in 256 combinations depending on how they are mixed.

Use this expression color for black and white images with gradient, black and white images to be displayed on Web sites, 
and so on.

Gray (black, white and transparent)

Gray (black and transparent)

Gray (white and transparent)

Color

This expression color allows you to use approximately 16.77 million colors.

It allows you to use almost all colors the human eye can perceive. Use this expression color in chromatic images such as 
color illustrations and color manga.

Regarding the layer icons

The following layer icons are used for monochrome, gray and color layers.

Squares on the bottom right of the monochrome and gray icons indicate the used drawing colors.

Monochrome Gray Color

However, no icon is displayed for the color configured in [Basic expression color].
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Creating a Layer for the Storyboard
Create a new layer and name it "Storyboard".

For details on how to create a new layer, see "Drawing illustrations with CLIP STUDIO PAINT - Advanced 
Part" → "Inking" → "Preparing the Layer" on Page 43.

Configure the expression color for the layer to draw with strokes in different tones. On the [Layer Property] palette, 
choose [Gray] for [Expression color].

   

The layer icon is displayed when 

the Expression color is changed.

Next, configure the layer color. Layer color is a function to display everything drawn on the layer in a specified color. 
Content drawn on different layers can be easily distinguished if each layer is configured with a different color.

To switch the layer color, click [Layer color] on the [Layer Property] palette.

Click to choose the 
layer color.Click to change to the 

current drawing color.

To display the [Layer Property] palette, from the [Window] menu, click [Layer Property] to turn on the check 
mark.

Configure the "Storyboard" layer as [Draft layer]. A layer configured as [Draft layer] is not referred by tools even if it is 
displayed. It is also excluded from printing and export.

To configure, select the "Storyboard" layer on the [Layer] palette and then select, [Layer] menu → [Layer Settings] → 
[Set as Draft Layer].

An icon is displayed when 
configured as draft layer.

A layer color is displayed 
on the layer icon.
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Drawing the Storyboard
Draw the storyboard using the [Pencil] tool and the [Eraser] tool.

For details on how to draw the storyboard, see "Drawing illustrations with CLIP STUDIO PAINT - Advanced 
Part" → "Pencilling" on Page 38.

Completing the Storyboard
Gradually complete the storyboard by drawing and correcting.

The storyboard is now complete.

To display or hide the crop mark and default border, select [View] menu → [Print Guide]. Switch as needed to 
work conveniently.
From the following step on, the procedure is described with the crop mark and default border hidden.
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Tips: Area visible at the time of printing/binding
The green frame in the figure below is called "bleed width". The inner line is called "cropped border" and indicates 
the area visible when printed. The outer line is called "bleed border" and indicates an extra margin to cope with any 
misalignment during printing or trimming.

The border inside the "cropped border" is called the "default border" and indicates the reference border to layout frames.

Enlarged view

Bleed border

Cropped border

Default border

Books are cut in accordance with the "cropped border"; however, a misalignment of a few mm may occur. This is the 
reason why "bleed width" are configured as extra margin. To occupy a page up to the paper edge, draw up to the outer 
border of the "bleed width".

Be sure the content you want to print is always drawn inside the "cropped border". Still, the content may be hidden 
when printed depending on the binding specifications. To be safe, make sure important content such as the dialogue and 
characters' facial expressions are drawn inside the "default border".

Draw up to the bleed width

(green area).

As shown in the figure above, the drawn content

extends up to the page edge after printing or

binding.

Draw dialogue, characters’ facial expressions

and the like within the default border

Creating Balloons and Dialogue
"Balloons" which are essential to express words in manga can be created in the dialogue layer.

Creating a Balloon
Choose black from the [Color Set] palette. Check that the main color on the [Tool] palette is black. Then, click to select.
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Check that the main color is 

black to select.

On the [Tool] palette, select [Text] → [Curve balloon]. Configure the [Tool Property] as follows:

Straight line

None

Draw the balloon's line by moving the mouse cursor over the canvas and clicking. To finish drawing the balloon, double 
click or close the line.

Click.

Click.

Click. Click.

Double click or 
close the line.

You now have the basic shape for the balloons. Creating a balloon creates a balloon layer on the [Layer] palette.
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Adjusting the Balloon Shape
Once the balloon layer has been created, adjust the shape and size with the [Object] tool.

 On the [Tool] palette, select [Operation] → [Object].

To enlarge or reduce the balloon, select a handle on the edge of the balloon and drag.

To reshape, select the balloon's line and drag its control point.

Drag the 
guide line to 
move.

Drag the 
handle to 
zoom in/out.

Drag the 
control point 
to reshape.

Drag the rotation 
controller to rotate.

Tips: Balloon's line
The balloon's line can be edited by Line color, Ground color, Brush Size and Brush shape on the [Tool Property] palette.

The
- Balloon’ s line and ground color
- Thickness of the balloon’ s line
- Shape of the brush for drawing 
the balloon’ s line
are editable.

Example: When the brush shape 
is changed to “dotted line”
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Attaching a Tail to the Balloon
On the [Tool] palette, select [Text] → [Balloon tail]. Then, on the [Tool Property] palette, set [Polyline] for [How to 
bend].

To attach a tail, drag the mouse cursor from inside to the outside of the balloon and click at the points you want the tail to 
bend. Then, double click to finish.

Click.

Click.

Click.
Double click.

Commit.

The tail can also be edited with the [Tool Property] palette and [Object] tool.

Lettering 
When the balloon is ready, input the words.

On the [Tool] palette, select [Text] → [Text] and then, change the font, font size and the like on the [Tool Property] 
palette.
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Click inside the balloon on the canvas to input text. Click outside the text area to commit the input text.

Clicking again with the [Text] tool after inputting a text allows you to input another text.

The input text can be corrected with the [Text] tool and [Object] tool.On the [Layer] palette, the input text is displayed in 
the balloon layer.

Temporarily hide the balloon layer to work on the drawing underneath.

 

To add a sketch easier, set [Opacity] of the "Storyboard" layer to 50%.

Tips: Editing the text
You can add the reading to words (text) input using the [Text] tool as well as adjust the space between lines and 
characters.

Before editing a text

Configuring the following setting in advance allows you to expand the variety of edits you can perform.

Open [File] on the [Preferences] dialog box by selecting [File] menu ([CLIP STUDIO PAINT] menu in Mac OS X) → 
[Preferences] and turn on [Render text like IllustStudio and ComicStudio].
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Adding reading to a text

With the [Text] tool, select the text to which you want to add the reading.

Click the [Sub Tool Detail] button on the [Tool Property] palette to open the [Sub Tool Detail] palette. Click [Reading] 
on the [Sub Tool Detail] palette. Clicking [Reading setting] displays a pop-up. Input the reading for the text in [Reading 
string] and press the [Enter] key to commit.

Clicking [Reading setting] 

displays a pop-up to input

the [Reading string].

The reading is added to the text.

Adjusting the space between characters and lines for the text

In the same way as when you added the reading, open the [Sub Tool Detail] palette.

To adjust [Word space], click [Font] on the [Sub Tool Detail] palette, and to adjust [Line space], click [Text] on the [Sub 
Tool Detail] palette.

Word space: 0.0, Line space: 4.0 Word space: -2.0, Line space: 4.0 Word space: 0.0, Line space: 4.0
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Adding the Frame Border
When drawing the frame border, creating a [Frame Folder] for each frame adds convenience as you 
will be able to work and correct on a frame basis.

Creating the Frame
On the [Tool] palette, select [Figure] tool → [Frame border] → [Rectangle frame].

Configure detailed settings on the [Tool Property] palette. Creating a frame border with the [Raster Layer] check box 
selected creates a raster layer. This layer will be used during inking.

By referring to the lines you drew on the storyboard, drag the mouse cursor over the canvas to draw the frame borders 
for frames 1 and 2.

Drag to commit.

The [Frame Folder] is created on the [Layer] palette.
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Selecting the [Frame Folder] on the [Layer] palette allows you to check the display area of that frame on the canvas. In 
the example below, though the drawing on the layer inside the [Frame Folder] extends up to the outside of the frame 
border, only the area displayed white is actually displayed as this is the display area of the frame image. 

Not displayed 
outside the frame

Create the [Frame Folder] for frame 3. On the [Tool Property] palette, turn off [Draw border] as this is a frame without 
frame border.

By referring to the storyboard, drag the mouse cursor over the canvas to commit the area of frame 3.

Drag.

The [Frame Folder] is created on the [Layer] palette.

When [Frame Folder] is created, a ruler along the shape of the frame border will also be created at the same time. 
You can use a drawing tool to add a frame border to [Frame Folder] without any frame border.

Adjusting the Frame Shape
Once you have created the [Frame Folder], adjust the shape and size of the frame border with the [Object] tool.

By clicking the triangular handle, you can expand the frame border up to edge of the canvas, crop mark, or adjacent 
frame border.
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Click.

The frame border 
expands up to edge of 
the canvas.

By configuring on the [Tool Property] palette, you can make more advanced edits.

Arrange the Frame Folders in ascending order: Frame 1 → Frame 2 → Frame 3. Then, move the balloon layer to the top.

Pencilling
Create separate layers for sound effects, characters, effects and the like to draw then separately from 
the draft.

Preparing the Layer
Create a draft layer folder and configure it as [Draft layer]. A layer folder can group multiple layers and can be used to 
configure display/hide settings, or layer attributes for all layers at once.

Select [Layer] menu → [New Layer Folder]. Name the created folder as "Draft". In addition, select [Layer] menu → 
[Layer Settings] → [Set as Draft Layer].

An icon is displayed when 
configured as draft layer.
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Select [Layer] menu → [New Layer] → [Raster Layer].

On the [New Raster Layer] dialog box, select [Color] for [Expression color] and create the layer.

Similarly, create plain-colored layers named "Sound effect", "Characters", "Effect" and "Background" in order, from top 
to down.

To easily distinguish the content drawn on each layer, use the [Layer Property] palette and configure a different layer 
color for each layer.

Drawing the Draft
On each layer, draw the draft by using the [Pencil] tool and the [Eraser] tool. Complete the drawing of sound effects, 
characters and background.
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Drawing the Draft of Effect Lines
On the "Effects" layer, you will draw the draft of effect lines. For that, have the ruler and the inking area for the effect 
lines defined at this point.

Tips: What is a ruler?
In the analog world, rulers and templates are used to draw regular lines and shapes. With CLIP STUDIO PAINT, you can 
create and use rulers with diverse shapes such as lines and figures.

By snapping the drawing tool to the created ruler, you can draw straight lines, circles, concentric lines and so on 
accurately while keeping the pen or brush touch. You can not only use straight line, curved line or shape ruler, but also 
[Special ruler] capable of drawing parallel lines, concentric circles or irradiation lines, and [Perspective ruler] capable of 
drawing backgrounds accurately.

Create the ruler.

Draw by snapping to the ruler.

Example: Use of [Concentric circle ruler]

　

On the [Layer] palette, check that the selected layer is "Effect".

On the [Tool] palette, select [Figure] → [Rurer]. On the [Tool Property] palette, select [Special ruler] → [Forcus curve].
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Click and move the mouse cursor over the canvas. Then, click once and move again. Double click to create an [Forcus 
curve ruler]. The point clicked first becomes the center.

Click. Click.

Double Click.

To correct the ruler, select it by clicking with the [Object] tool.

Using the created ruler and the [Pencil] tool, draw effect lines in frame 1 as if you were drawing the outline or shape of a 
cloud.

Next, create a ruler to draw the draft effect lines in frame 2. In this case, select [Special ruler] → [Focus line] on the 
[Tool Property] palette.

With the area to draw (the broken lines) in mind, draw the draft effect lines.

When you have completed the effect lines, disable the snap to special rulers. From the [View] menu, click [Snap to 
Special Ruler] to turn off.
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Since the created rulers will also be used in inking, enable their use in other layers. On the [Layer] palette, change [Set 
Showing Area of Ruler] to [Show in All Layers].

The draft is now complete.



101

Monochrome Manga Part [PRO/EX]

Inking Characters
The final drawings will be created by inking, filling in one color and adding tone.

Ink over characters based on the draft. Create a layer for inking inside each [Frame Folder].

Rename the "Layer 1" created inside the "Frame 1" folder along with the border as "Frame 1 character main line".

Change the main color for the [Tool] palette to black.

On the [Tool] palette, select [Pen] tool → [Pen] → [G-pen] to draw the main lines of the character using black.

Similarly, create the character in frame 3.  Rename "Layer 3" as "Frame 3 character main line" and ink over the character 
with the [Pen] tool and [Eraser] tool as with frame 1.
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The main lines of the character in frame 3 are now drawn.

For details on inking, see "Drawing illustrations with CLIP STUDIO PAINT - Advanced Part" → "Inking" on 
Page 43.

Adding Fill in Monochrome, Tone and Gradient
Fill in monochrome, Tone and Gradient have dedicated layers. They are used to add expression to the 
clothes wore by the characters, the shadow and clouds.

Tips: What are Fill in monochrome, Tone and Gradient layers?
CLIP STUDIO PAINT comes with the following dedicated layers. 

· [Fill in monochrome] layer: A layer that is created filled in a specified color.

· [Tone] layer:   A layer created with the specified toning.

· [Gradient] layer:  A layer created with the gradient drawn.

Stacking the Fill in Monochrome Layer
Place a layer filled in white below the layer with the main lines of the character to prevent the background from being 
visible through the character. 

Select [Layer] menu → [New Layer] → [Fill]. Select [White] on the dialog box for selecting a color to create a layer that 
fills the entire frame in white.
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Name the [Fill in monochrome] layer as "Frame 1 character white mat" and place it below the "Frame1 character main 
line" layer.

Using [Refer other layers] of the [Fill] tool, fill the background area in transparent color.

Fill in 
transparent 
color.



104

Drawing Manga with CLIP STUDIO PAINT

To check, hide the "Paper" layer. Check that only the area underneath the character is filled in white.

When you have finished checking, display the "Paper" layer again.

Similarly, create a white mat for frame 3.

Stacking the Tone Layer
With [Tone] layer, stack tone to the character in frame 1.

With the "Frame 1 character white mat" layer selected, select [Layer] menu → [New Layer] → [Tone]. Configure the 
[Simple tone settings] dialog box as follows:
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Tone is stacked to the whole frame.

Move the created [Tone] layer down to below the "Main line" layer.

To have the tone stacked only where necessary, erase the tone image by pressing the [Delete] key.

On the [Layer Property] palette, configure [Yes] for [Mask expression] → [Posterization].

Using [Refer other layers] of the [Fill] tool, fill the shoulder in the drawing color.

Similarly, fill the areas where you want to stack tone with the [Fill] tool, [Pen] tool, or [Soft] mode of the [Air brush] tool.

Fill in drawing 
color.

Next, cut the tone. To better recognize the tone, convert the [Tone] layer to gray.

Tips: What is Layer Toning?
CLIP STUDIO PAINT can express a colored layer as tone.

The created [Tone] layer can also be converted to a gray layer by turning off [Tone] in the [Layer Property] palette. In 
this guide, gray areas and gradient will all be toned in the end.

On the [Layer Property] palette, click [Tone] to turn off.

The tone changes to gray.
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Cut the gray by using the [Eraser] tool and/or transparent [Pen] tool and add gloss with black [Air brush] or the like.

On the [Layer Property], click [Tone] to turn on. This is the end of operations on the tone.

“Tone”　　on.

Stacking Gradient
Using the [Gradient] layer, paint shadow for the character in frame 1.

Selecting [Layer] menu → [New Layer] → [Gradient] with the "Frame 1 character white mat" layer selected creates a 
layer with gradient.

First define the areas to which you want to add gradient as the gradient can be adjusted afterwards.

As with tone, erase the gradient image by pressing the [Delete] key. Using [Refer other layers] of the [Fill] tool, fill the 
areas to which you want to add shadow in the drawing color.
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When you have finished defining the areas to which you want to add gradation, adjust the gradient.

Select the [Object] tool. The handle to edit the start and end positions of the gradient is displayed on the canvas. Drag the 
starting point and/or end point to adjust the position(s).

By configuring settings on the [Tool Property] palette, you can create more sophisticated gradients.

Tasks to Be Performed Per Frame
Similarly, perform fill, add tone and add gradient for other areas.

Frame 1
For frame 1, add texture by separating layers for each accessory wore by the character, and cutting the shadow edges 
with [Tone scraping] of the [Air brush] tool.

Frame 2
For frame 2, stack two gradient layers to express the clouds. Select the [Gradient] layer with the [Object] tool to change 
color and shape.

Frame 3
For Frame 3, the character's shadow is realized by cutting the [Fill in monochrome] layer with [Tone scraping] of the 
[Air brush] tool. The clouds in the background are realized by toning the clouds drawn on the Gray layer with the 
[Watercolor] tool and/or [Finger tip] tool.
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The layer structure of each frame is now as follows:

Fill in monochrome, Tone and Gradient are complete. Hide the background and the character draft as they will not be 
used anymore.
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Inking Effect Lines
Inking of effect lines will be performed using the special ruler created during pencilling.

Inking the Effect Lines in Frame 1
Within the "Frame 1" folder, create a new monochrome layer named "Frame 1 effect lines" and place it below "Frame 1 
character white mat". Hide the "Frame 1 background gradation" layer.

From the [View] menu, click [Snap to Special Ruler] to turn on as the special ruler for effect lines will be used.

From the [View] menu, click [Change Special Ruler Snap] to switch to the [Forcus curve ruler]. The lines of the snapped 
ruler change to violet.

Select the "Frame 1 effect lines" layer and with [Pen] → [For effect line], ink over the effect lines by referring to the draft 
layer.
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When you have finished inking the effect lines of frame 1, display the "Frame 1 background gradation" layer you hidden.

Inking the Effect Lines in Frame 2
Also ink over the effect lines in frame 2 with the [For effect line] tool, by creating a monochrome layer named "Frame 2 
effect lines (black)" and changing the ruler to snap. Hide the gradient for the clouds as it hides the draft.

After displaying the gradient again, ink over the effect lines in white so that they stand out. 

Create a new layer named "Frame 2 effect lines (white)" below "Frame 2 effect lines (black)". Then, on the [Layer 
Property] palette, configure white for drawing color.

Draw white effect lines in between the black effect lines as if drawing end of lines.

Draw white lines in-between 
black lines (displayed in green 
as an example).

Inking is now complete. Hide the draft effect lines as it will not be used anymore.
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Adding Sound Effect
As with the characters, the sound effect is also inked over with the [Pen] tool and painted with the [Fill 
in monochrome] layer and [Gradient] tool.

Temporarily hide the frame 1 to 3 layers as they are hiding the draft of the sound effects. Create a layer folder at the top 
and name it "Sound effect". Inside the folder, create a new monochrome layer and name it "Frame 1,3 sound effect _
outline".

Sound Effects in Frames 1 and 3
In the "Frame 1,3 sound effect outline" layer, ink over the sound effects in frames 1 and 3 with the [Pen] tool. For the 
sound effect in frame 3, create a black [Fill in monochrome] layer and fill.

Sound Effects in Frame 2
For sound effects in frame 2, first draw the outline of the sound effect in a new monochrome layer named "Frame 2 
sound effect_outline". 
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Once you have created and filled the new gradient layer named "Frame 2 Sound effect_gradation", hide the "Frame 2 
sound effect_outline" layer.

Create a white [Fill in monochrome] layer named "Sound effect_white mat" layer below the "Frame 2 sound effect 
gradation" layer. Then, select [Fill] tool → [Refer other layers] to make transparent everything except the sound effect.

Tone the [Gradient] layer. On the [Layer Property], click [Tone] to turn on. This is the end of tone operations.

Adding Edge to Sound Effects
Add edge to the sound effects.

Select the "Sound effect" layer folder, and click and turn on [Border effect].  Select [Edge] from [Border effect].

Edge

* Here, the edge is green to make the white edge visible.
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Adding Highlight
Finish by adding highlight.

Create a new layer at the top of the layers and name it "Highlight". On the [Layer Property] palette, configure white for 
drawing color and draw the highlight with the [Pen] tool or the like.

* Here, the edge is green to make the highlight in white visible.

Finally, display the frames 1 to 3 layers, the "Paper" layer and the "Balloon" layer that were hidden to complete.
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Completing
When the manga is complete, save the file and/or print.

Saving the File
With CLIP STUDIO PAINT, you can save your files in CLIP STUDIO PAINT format (extension: lip), BMP, JPEG, 
PNG, TIFF, Targa, Adobe Photoshop document (extension: psd) and Adobe Photoshop large document (extension: psb).

To save in BMP, JPEG, PNG, TIFF or Targa, select [File] menu → [Export (Single Layer)] and then, the file format in 
which you want to save.

On the [Export Settings] dialog box that is displayed after the folder and file name to save have been specified, select 
[Duotone] for [Expression color] and save.

Printing
To print, select [File] menu → [Print Settings]. On the [Print Settings] dialog box, select [Duotone] for [Expression color] 
and print.

[Export Settings] dialog box [Print Settings] dialog box
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Drawing Sequence of Colored Manga
This part describes how to draw color manga based on the sequence below.

Adding Border Line, Dialogue and 
Balloons
Based on the draft, create the border line and input 
words using the [Text] tool. Enclose the input text with 
the [Balloon pen] tool to add the balloons.

Inking
Ink over with the [Pen] tool based on the draft.
Line drawing is produced as a result of this task.

Coloring
Createlayers for coloring for each part and the like. 
Using the [Fill] tool apply the base color and then, 
paint over.

Adding Effects and Making 
Adjustments
Finish the color manga by adding effects and
adjusting the colors.

Preparation and Pencilling

Make preparations for drawing the manga, and
draw the draft.
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Pencilling
Create a file and draw the draft.

Creating a New File
After adapting the environment settings to make it appropriate for the work, create a new canvas.

Select [File] menu → [Preferences]. (In the Mac OS X version, [CLIP STUDIO PAINT] menu → [Preferences].)

On the [Preferences] dialog box, select [Ruler/Frame/Unit], then [mm] for [Unit] and click [OK].

From the [File] menu, select [New].

On the [New] dialog box, configure the size and other items as required, and click [OK]. The settings for this example 
are as follows:



118

Drawing Manga with CLIP STUDIO PAINT

Creating a Layer for the Draft
Create a new layer for drafting and configure.

Renaming the Layer
Double click the name field of Layer 1 and input "Draft".

Configuring the Layer Color
Layer color is a function to display everything drawn on the layer in a specified color.

To switch the layer color, click [Layer color] on the [Layer Property] palette.

Click to change to
the current drawing
color.

Click to select the
layer color.

To display the [Layer Property] palette, from the [Window] menu, click [Layer Property] to turn on the check 
mark.

Configuring as Draft Layer
Configure the "Draft" layer as [Draft] layer.

A layer configured as draft layer is not referred by the [Fill] tool, [Masic wand] tool and the like. It is also excluded from 
printing and export.

To configure, select the "Draft" layer on the [Layer] palette and then select, [Layer] menu → [Layer Settings] → [Set as 
Draft Layer]. Configuring the layer as [Draft] displays a pencil icon on the [Layer] palette.

An icon is displayed when 
configured as draft layer.

A layer color is displayed 
on the layer icon.
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Drawing the Draft
On the [Tool] palette, select the [Pencil] tool to draw the draft. Draw the frames, dialogue and characters with the story 
and layout in mind.

The [Eraser] tool on the [Tool] palette allows you to erase lines drawn with the [Pencil] tool.

[Eraser] tool

[Pencil] tool

The draft is complete.
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Adding the Border Line
Frames will be cut in accordance with the draft once the border line is added to the manga.

Adding the Border Line
Add the border line.

Select [Layer] menu → [New Layer] → [Frame Border Folder]. The settings for this example are as follows:

Clicking [OK] creates a border line along the default border.

On the [Tool] palette, select [Operation] tool → [Object].
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Align the border line with the draft.

Place the mouse cursor on the line outside the border line. When its shape changes to that of the move cursor, drag the 
border line so that its top right corner matches that of the draft.

Drag

Place the mouse cursor on a blue handle on the border line. When its shape changes to that of the zoom in/out cursor, 
drag the border line so that its bottom left corner matches that of the draft.

Drag

On the [Tool] palette, select [Figure] tool → [Frame border] → [Divide frame border]. On the [Tool Property] palette, 
adjust the values of [Horizontal space] and [Vertical space] as appropriate, in accordance with the space between border 
lines you want.
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Drag on the canvas along the draft to cut the border line and create frames. First drag horizontally to cut the manga into 
an upper and a lower frame. Then, drag on the upper frame vertically to cut it into a left and right frame.

Drag

Drag

On the [Tool] palette, select [Operation] tool → [Object] to adjust the frame size.

Placing the mouse cursor on the blue handle on the frame changes the shape of the mouse cursor to that for resizing the 
frame. Drag to resize.

Drag

On the [Tool Property] palette, turn off [Work with another frame border] to adjust the frame one by one in accordance 
with the draft.
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The frame borders are complete.

Creating Balloons and Dialogue
With the [Text] tool, input the dialogue. Regarding the [Text] tool, also see "Drawing Manga with 
CLIP STUDIO PAINT- Monochrome Manga Part" → "Creating Balloons and Dialogue" on Page 88.

Canvas View Settings 
Before inputting the dialogue, change the view settings for the canvas. For this example, configure as follows:

●  Select [View] menu → [Print Guide] to hide the crop mark and default border. To display the crop mark and default 
border again, perform the same operation.

●  On the [Layer] palette, select "Draft" and configure 60% for opacity.
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Lettering
On the [Tool] palette, select [Text] tool → [Text]. On the [Tool Property] palette, configure [font], [Size] and [Text 
direction] as follows:

Click where you want to input the words.

Click and input

Creating the balloons
Add balloons using [Cloud balloon].

On the [Tool] palette, select [Text] tool → [Balloon pen] and draw a balloon as if enclosing the words. Drawing the 
balloon around the words automatically integrates the text and balloon layers.

Normal text Text in balloon

Once the text and balloon are integrated, you can change the balloon size or angle, or move the balloon by 
selecting [Operation] tool → [Object] on the [Tool] palette.
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Add balloons around all words.

Adding the dialogue and balloons is complete.
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Inking
Draw the line drawing by inking over the draft.

Inking Characters
On the [Tool] palette, select [Pen] tool → [Mapping pen] to ink over.

The [Eraser] tool on the [Tool] palette allows you to erase the inked lines. By using the [Pen] tool and [Eraser] tool 
simultaneously, you can redo as many times as necessary, until you are satisfied with the lines.

Having separate layers is convenient for making corrections later. So, for example, divide frames and characters into 
separate layers. Furthermore, if an inked line runs over another frame, you can select the run over portion with the 
[Marquee] tool and the like and erase by selecting [Edit] menu → [Clear].

Ink over characters by hand using lines of diverse intensity.

 

Clicking the [Show/Hide Layer] icon on the [Layer] palette allows you to toggle the layer visibility. By hiding the 
"Draft" layer, you can check only the inked lines.
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Inking Using Figure Tools
The gatling gun is drawn using the [Figure] tool. The procedure below is described based on the first and second frames 
as an example.

First Frame
Draw the straight lines in the first frame one by one as the left and right lines have different angle.

On the [Tool] palette, select [Figure] tool → [Diret draw] → [Straight line] to draw a straight line over the leftmost line. 
Make a duplicate of the layer where you drew the straight line by selecting [Layer] menu → [Duplicate layer]. On the 
[Tool] palette, select [Move layer] to move the duplicated layer (line). Repeat this operation as many times as necessary 
(this will become the red lines in the figure below).

Similarly, draw a straight line over the rightmost line and make duplicates (this will become the blue lines in the figure 
below).

In the figure below, lines are shown overlapped with the finished illustration to indicate the correspondence between the 
line drawn with the [Figure] tool and the part of the gun. Furthermore, lines drawn with the [Figure] tool are shown in 
red and blue.

Draw the straight lines
on the left and right.

Copy the lines on the left
and right, and lay out.

Adjust by adding lines
drawn by hand for better
fit with the character’ s lines.
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Second Frame
The gatling gun in the second frame is drawn as follows: 

First, create another layer for the [Figure] tool, apart from that for inking.

Then, on the [Tool] palette, select [Figure] tool → [Direct draw] → [Ellipse] to draw the gun. To draw circles, drag with 
the [Shift] key held down. Here also, make duplicates of the drawn circle and lay them out.

Circles drawn using
[Figure] tool.

When you have finished drawing with the [Figure] tool, reduce the opacity of the figure layer and ink over the lines by 
hand. Instead of using homogeneous lines by the tool, ink over by hand to give texture.
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Inking Effect Lines
Using rulers, add effect lines to each frame.

Drawing Saturated Lines
For the first and third frames, create an [Forcus line ruler] to draw saturated lines. The description below is based on the 
first frame as an example.

On the [Tool] palette, select [Figure] tool → [Ruler] → [Special ruler], and then select [Forcus line] for [Specify ruler] 
from the [Tool Property] palette.

On the canvas, click the point of gaze (vanishing point). The [Forcus line ruler] is created at the clicked point.

Click the point to be
the center of the ruler.

The ruler is created.
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Thereafter, select [Pen] tool → [For effect line] from the [Tool] palette to draw the saturated lines.

On the [Tool Property] palette, configure items such as [Starting] and [Ending] as required.

To move the center of the ruler, select [Operation] tool → [Object] on the [Tool] palette and drag the ruler.

Drawing Speed Lines
Create a [Parallel line ruler] to draw speed lines.

On the [Tool] palette, select [Figure] tool → [Ruler] → [Special ruler], and then select [Parallel line] for [Specify ruler] 
from the [Tool Property] palette.

On the canvas, drag at the angle you want to give the speed lines.

Drag to create the
[Parallel line ruler].

To change the angle of the ruler, select [Operation] tool → [Object] from the [Tool] palette and drag the handle 
on the ruler.
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Draw the speed lines with the [Pen] tool.

Speed lines with the same
angle as the ruler are drawn.

Inking is now complete.
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Coloring 
Once inking is complete, the next step is to color.

Sound Effect
Add the sound effect. Two types of sound effect will be added to the first frame, one with "all black letters" and the other 
with "filled outline letters".

Create a new layer. Then, select the [Pen] tool from the [Tool] palette to draw the letters using only black and the 
surrounding border.

Create a new layer to fill inside the border. On the [Tool] palette, select [Fill] tool → [Refer other layers] to fill inside the 
border. Perform this step also for the other frames.

Fill the outline letters
of the sound effect.

Addition of the sound effects is complete.
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Basic Coloring
Create a new layer for each character part and frame to color.

On the [Tool] palette, select [Fill] tool → [Refer other layers] to fill each part with the base color.

Tips: When small unfilled areas remain
When small areas remain unfilled, select [Fill] tool → [Close and fill] on the [Tool] palette to enclose the small unfilled 
areas. In this way, you will be able to fill only the closed areas inside the selection.

Only the closed areas 
inside the selection are
filled.
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Coloring the Characters
Select the colored layer and click [Lock Transparent Pixel] on the [Layer] palette to not run over the filled areas. Paint 
over with the [Brush] tool → [Watercolor] on the [Tool] palette. Similarly, paint over each colored layer.

For [Lock Transparent Pixel], see "Drawing Illustrations with CLIP STUDIO PAINT - Advanced Part" → 
"Adding Shadow"→ "Specifying [Lock Transparent Pixel] for the Layer for Shadow Painting" on Page 66.

Coloring the Background
In the same way as with characters, paint over the background with the [Brush] tool → [Watercolor] on the [Tool] palette.

Regarding the areas where the saturated lines or speed lines are drawn, paint using the special rulers created at the time 
of inking. Painting along the saturated lines and speed lines makes the illustration more impressive.

On the [Layer] palette, click the icon of the ruler created at the time of inking and drag to the layer for the background. 
This changes the ruler range to the layer for the background.

Drag the ruler
icon.

Paint over along the ruler using colors darker and lighter than the base color.
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Coloring is complete.
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Effects and Adjustments
Complete the color manga by adjusting the colors throughout the entire manga and adding various 
effects.

Adding Edges
Add a white outline for highlight to the sound effect in the second frame.

On the [Layer] palette, select the layer where the sound effect for the second frame is drawn, click [Border effect] on the 
[Layer Property] palette.  After selecting [Edge] from [Border effect], change the value of [Thickness of edges] to make 
the outline thicker.

Edge

Changing the Color of the Line Drawing
For portions of the line drawing whose color is too strong with respect to the surrounding, change the color of the line 
drawing to make it fit better.

Select the line drawing layer and click [Lock Transparent Pixel] on the [Layer] palette. Paint over with a color closer to 
the surrounding.

When only the line drawing is visible

When colors are made visible

Line drawing colored
to fit the surrounding
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Changing the Paper Color 
Change the paper color to change the color outside the frames. Double click the [Paper] layer on the [Layer] palette to 
display the dialog box for choosing a color. On the dialog box, you can configure the paper color.

Double click

Configure the color on the
dialog box to choose a color.

The paper color is changed.

Adjusting the Overall Tone
Lastly, adjust the overall tone.

Create a new layer at the top of the layers and fill it in brown. Change the [Combine mode] for the layer to [Overlay] and 
reduce the opacity to 70%. The entire manga looks warmer.

Create a layer at the top filled in
brown and configure.
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The color manga is complete. Select [File] menu → [Save] to save the completed color manga.
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